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Conventions
This manual uses the following conventions:

! or → Connects commands. Commands following the arrow
appear on submenus. For example

File!Load  or  File→Load

* One or more characters can occupy the asterisk's
position. Also known as a wildcard.

. In text, introduces a procedure that explains how to do
a task.

Ctrl-F Press the keys simultaneously.

↵↵ The return key. Press this key after typing data in a
data entry box or on a message line or to accept a
default. You can click left in many P-CAD tools instead
of pressing ↵↵.

Enter Indicates you need to press ↵↵ after typing data.

Spacebar The space bar. You can use this key to digitize a point
within the drawing area.

italics Indicates variable characters.

boldface Indicates characters you enter from the keyboard; for
example

Enter sheet7  in the data entry box.

boldface Indicates variable characters you enter from
italics the keyboard; for example

Enter filename  in the data entry box.

Click left Press and release the left button (button 1) on the
mouse.
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Click middle Press and release the middle button (button 2) on the
mouse.

Click right Press and release the right button (button 3) on the
mouse. If you are using a two-button mouse, press Ctrl
and button 2 simultaneously to clickright.

Cycle Click left repeatedly on a cycle box until the item you
want is selected. A cycle box is indicated by ◊.

Select Move the cursor to an item or point and press ↵↵,
spacebar , or click left.
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About This Manual
The PCB Tools manual describes the PCB Tools module, one of
five major elements of the P-CAD system.

This manual is designed for handson use alongside your computer.
Use this manual after P-CAD is installed. You need to understand
basic concepts of printed circuit board design, CAD, CAE, and basic
DOS commands to use P-CAD. As a starting point, the Tutorial
manual provides a good overview of the system.

The PCB Tools manual consists of 16 chapters, 4 appendixes, and
an index. Each chapter contains conceptual and procedural
information that explains how to use the PCB Tools module. A
conventions page follows this section.

Chapter 1 “Overview” explains how the PCB Tools module fits
in the P-CAD design flow and briefly discusses the
tools in the module.

Chapter 2 “Configuring the PCB Editor” explains how to set
values the PCB Editor uses.

Chapter 3 “Setting the PCB Editor Environment” discusses what
you need to do outside and inside the PCB Editor
before you use it.

Chapter 4 “Using the PCB Editor Commands” provides an
overview of the commands in the PCB Editor.

Chapter 5 “Using the Aperture Table Editor” describes how to
use the Integrated Aperture Table (IAT) feature to
define apertures used in photoplotting your PCB.

Chapter 6 “Using the PCB Editor” explains how to create and
edit a printed circuit board design.
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Chapter 7 “Placement” describes how to place components
automatically and optimize interactive placement.

Chapter 8 “Dimensioning” describes how to show the realworld
dimensions of objects in a PCB database.

Chapter 9 “Using Surface Mount Technology” describes
features in the PCB Editor that support surface
mount designs.

Chapter 10 “Advanced Editor Topics” tells you how to use
executable files to rerun sequences of commands,
and how to program and use function keys.

Chapter 11 “Generating Reports” explains how to extract reports
such as bills of materials, node lists, and component
lists from your PCB database.

Chapter 12 “Checking for Design Rules Violations” explains how
to perform design rules checks on your PCB
database.

Chapter 13 “Generating Drill Data” explains how to create an NC
drill file that your PCB manufacturer can use for
fabricating your printed circuit boards.

Chapter 14 “Generating AutoInsertion Data” explains how to
create a file that can be used to program factory
automation equipment for autoinsertion or
pickandplace operations.

Chapter 15 “Hardcopy” explains how to create files that can be
printed, penplotted, or photoplotted.
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Chapter 16 “Converting Netlists to PCB Layouts” explains how to
convert an ASCII netlist to a P-CAD database.

Chapter 17 “Using PDIF File Reader” explains how to convert an
ASCII file that's in a PDIF database interchange
format to a P-CAD database.

Chapter 18 “Using PDIF File Writer” explains how to convert a
P-CAD database to an ASCII file that's in a PDIF
database interchange format.

Chapter 19 “Using EZPlot” describes a P-CAD utility that
automates the creation of multiple plot files for a
PCB database.

Chapter 20 “Editing Report Files” explains how to use a text
editor to add, edit, delete, rename, copy, and print
report files or other ASCII files.
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Overview 1
The PCB Tools module contains all the tools necessary to design a
printed circuit board (PCB). To understand how PCB Tools works,
you need to know the answers to these questions:

• Where does PCB Tools fit in the P-CAD design flow?

• What are the PCB Tools?

Where PCB Tools Fits in the Design Flow
The PCB Tools module is one of five modules that make up P-CAD.

• Design Manager creates and maintains project files.

• Schematic Tools creates and edits schematic databases.

• PCB Tools creates and edits printed circuit board databases.

• Library Manager sets the search paths and libraries for each
design. The Library Manager also creates and edits parts and
symbols and maintains the archived libraries in which they
reside.

• Interfaces links the input and output of P-CAD to other CAD
systems.

PCB Tools is used to design the PCB and generate the tool data
necessary for fabrication. The key tasks accomplished with the PCB
Tools module are component layout, net assignment or optimization,
trace routing, aperture table editing, design rules checking, pen-
plotting and photoplotting, and generation of data for PCB
fabrication and assembly of the PCB. The end-products include a
PCB database, log files for back-annotating schematics, hardcopy
for design checking, Gerber data files, report and design
documentation files, and NC drill data files.

Before you use the PCB Tools module, you need to do the following:

• Define your design files with the Design Manager module.
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• Define the libraries and search paths with the Library Manager
module.

• Create the parts you need with the Part Editor in the Library
Manager module, or extract the parts from a P-CAD part library
archive.

What Are the PCB Tools
After you select the PCB Tools icon, the screen shown in Figure 1-1
appears

The PCB Tools screen provides access to all the tools you need to
design a printed circuit board.

• Editor Configuration sets the default configuration values used

by the PCB Editor. These default values include the
programmable function key file specification, pin, via, and flash
size, rotate padstacks, rotate text in four directions, draw round
lines, allow addition of uncom- mitted pins, display trace length,
use display list, load active PCB, and design rules checking, and
automatic clear flash.

Figure 1-1.  PCB Tools Screen
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• PCB Editor is the graphics editor where you design and edit your

PCB databases. You can also edit an aperture table from the
PCB Editor.

• Autorouter automatically routes traces in your PCB.

• Design Rules Check performs DRCs on your PCB database.

• EZPlot automates the creation of multiple plot files for a PCB

database.

• PDIF File Reader converts a PDIF database in ASCII format to

P-CAD format. By using this tool, you can transfer a PCB from
other systems to P-CAD.

• PDIF File Writer converts a database in P-CAD format to PDIF

ASCII format. This tool provides an interface to other PCB
systems.

• Hardcopy produces hardcopy output from a plot file.

• Report Generator creates component, node, packaging, wire,

and materials lists.

• Drill generates NC drill data for fabrication of the PCB.

• Auto-Insertion generates an ASCII file that can be used to

program auto-insertion and pick-and-place robots for automation
of PCB assembly.

• Netlist Conversion converts an ASCII netlist to a P-CAD binary

database.

• Aperture Table Editor defines apertures used in plotting and

photoplotting your PCB.

• Report Editor lets you edit, add, delete, rename, copy, and print

report files or other ASCII files associated with the design.
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Configuring the PCB Editor 2
The Editor Configuration tool sets values and options that the PCB
Editor uses. The values and options are as follows:

• Rotate Padstacks determines whether the graphic and flash
entities in padstacks are rotated when a component is rotated.

• Rotate Text in Four Directions determines how component text
is rotated when a component is rotated.

• Draw Round Lines determines whether the corners or vertices of
lines and wires are displayed as round or square.

• Allow Adding Uncommitted Pins controls whether uncommitted
pins are added to a net when a wire crosses them.

• Display Trace Length controls whether the system displays the
length of a trace as you enter it.

• Use Display List determines how quickly the display redraws.

• Auto Clear Flash controls whether clearance is automatically
created around flashes during polygon pouring.

• Load Active PCB determines whether the system loads a PCB
when you start the PCB Editor.

• Online DRC controls whether the system checks for spacing
violations as you enter wires.

• Display Verbose Warnings lets you control which warning
messages you see.

• Dynamic Ratsnest Display lets you control whether the PCB
Editor displays a dynamic ratsnest as you enter a wire.

• Edit Design Rules File lets you edit the Design Rules file. The
Design Rules file lets you set up spacing allowances for a DRC.

• Rules Filename lists the Design Rules filename.

• Edit Check Pass File lets you edit the Check Pass file. The
Check Pass file defines which layers are checked during a DRC.
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• Pass Filename lists the Check Pass filename.

• Function Key Filename automatically loads a set of defined
function keys when you start the PCB Editor.

• Pin Size specifies the default pin size.

• Via Size establishes the default size for vias.

• AutoSave Configuration displays the AutoSave Configuration
dialog box. This dialog box displays the three AutoSave options:
Auto-Save Interval, Auto-Save Extension, and Auto-Save
Archive.

• AutoSave Interval determines how many minutes pass before
the system displays a prompt asking whether you want to save
the database.

• AutoSave Extension allows you to supply a backup filename
extension that the system uses at each AutoSave interval until
you select File→Save, when the database is saved to its original

name.

• Auto-Save Archive indicates how many archive files to save
during an editing session. You can enter a number between 1
and 99. When you enter a number, the system grays out the
Auto-Save Extension field.

• Flash Size determines the size of the graphic that represents
photoflash entities in the Part Editor, and in the PCB Editor
when the aperture table is not attached.

The DOS Shell button takes you to the PCAD DOS Shell where you
can enter DOS commands. The Save Default and Copy Default
buttons let you save or copy default configuration values to a special
file that is accessible from any directory. The Cancel button exits the
Editor Configuration screen without implementing your changes. The
Exit button exits the Editor Configuration screen and implements
your changes.

Opening the Editor Configuration Screen

After you select Editor Configuration, the screen shown in Figure 2-1
appears.
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Figure 2-1. Editor Configuration Screen

Rotating Padstacks

The Rotate Padstacks option lets you specify that graphic and flash
data in your padstacks be rotated when you rotate components.

Note:  Graphic and flash aperture data in padstacks is rotated in
different ways. You can predefine an aperture's rotation in the
Aperture Table Editor. If you later rotate the component in the PCB
Editor with Rotate Padstacks ON the graphic and flash data rotate
along with the component.

To enable padstack rotation

• Fill the Rotate Padstacks check box. The filled check box
indicates the option is enabled.
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Rotating Text in Four Directions

The Rotate Text in Four Directions option lets you control how you
view and plot component text. When the option is off (the default
value), text rotation is forced so it reads correctly (from left to right).
For example, text for an upside down component appears right side
up, and text for a component rotated 180 degrees is rotated 180
degrees, but you're able to read it. When the Rotate Text in Four
Directions option is on, text rotates with the component; text for an
upside down component appears upside down, and text for a
component rotated to 270 degrees is rotated to the same orientation.
Any plot you generate from the database shows component text
exactly as it appears on the screen. You could, therefore, generate
two plots from the same database—one in which component text is
rotated and one in which it isn't.

Rotate Text in Four Directions affects only how you view and plot
component text. It doesn't change the way text is stored in the
database. For example, if you enter component text upside down,
it's stored that way even though you view it right side up when the
option is off. Common practice is to set the option to off.

To rotate component text with the component

• Fill the Rotate Text in Four Directions check box. The filled
check box indicates that component text will be viewed and
plotted in four orientations: top-to-bottom, bottom-to-top, left-to-
right, and right-to-left.

Drawing Round Lines

The Draw Round Lines option determines whether graphic lines or
wires (traces) have radiuses at their end or corner points. When the
Draw Round Line option is enabled, the display of trace and line
vertices on the screen is representative of how they'll appear in a
plot or on film.

When the PCB is very dense, the additional processing incurred by
displaying round vertices, instead of square, can result in some
increase in redraw time.

To enable the Draw Round Lines option

• Fill the Draw Round Lines check box. The filled check box
indicates the option is enabled.
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Allowing the Addition of Uncommitted Pins

The Allow Adding Uncommitted Pins option controls whether or not
uncommitted pins are added to a net when they're crossed by a wire.
When the option is on, if you cross an uncommitted pin when using
the  Enter →Wire or Edit →Enter Wire command, the pin is
automatically added to the net. When the option is off, an error
message appears when you cross an uncommitted pin, and you
must select a new location for the wire.

While editing the PCB database, you can override this setting with
the /ucp (uncommitted pin checking) command.

To automatically add uncommitted pins when they're crossed
by a wire

• Fill the Allow Adding Uncommitted Pins check box.

Displaying Trace Lengths

The Display Trace Length option controls whether the system
displays the length of a trace as you enter it. When this option is on,
the actual and potential lengths of the trace appear on the message
line.

• The actual length is the length of the entire net. The system
updates this number each time you select a point.

• The potential length is the actual length plus the length that's
added if you select the current point. This number is updated as
you move the cursor.

When this option is off, the length of the trace doesn't appear.

To display the length of a trace as you enter it

• Fill the Display Trace Length check box.
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Using the Display List

The Use Display List option determines how quickly the screen
redraws.

• If the Use Display List option is on, the system creates an
internal list of the graphic elements in the database. When
redrawing the screen, the system uses this internal list to
recreate the graphic elements.

• If the Use Display List option is off, the system must search for
each graphic element in the database. This takes longer than
reading the internal list file.

In most cases, turning on the display list decreases the time it takes
to redraw the screen. However, if you have a large database and not
enough RAM, using the display list may increase the redraw time.

To turn on the display list so the screen redraws quickly

• Fill the Use Display List check box. When the check box is filled
the display list is stored in memory and the screen redraws
quickly.

Creating Clearance Around Flashes Automatically

The Auto Clear Flash option controls whether clearance is
automatically created around flashes during polygon pouring.

• If the Auto Clear Flash option is on (the default value), the
system automatically creates clearance around all flashes when
you pour polygons over them. Flash and polygon layer names
must be specified in the DRC check pass file before you attempt
to clear a polygon around a flash. The clearance distance for
automatic flash clearing is specified by using the Environment
→Polygon Flash Clearance command.

Refer to Using Design Rule Checking in this chapter for
information on how to perform online DRC check passes on
layers with flashes.

• If Auto Clear Flash is off, you can turn it back on while working
in the PCB Editor by using the /acf keyboard command.
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• When Auto Clear Flash is off, you can also create areas of
clearance around flashes inside intelligent polygons by using the
Environment→Clear Flashes command. Refer to the Command
Reference manual for details about using this command.

Note:  Thermal and target flash apertures are ignored during
polygon pouring; that is, thermal and target flash apertures will  not
be cleared.

To automatically clear flashes during polygon pouring

• Fill the Auto Clear Flash check box. When the check box is
filled, flashes and polygons specified on the same DRC check
pass layers are merged and clearance is created according to
what is specified for  Environment→Polygon Flash Clearance.

Loading the Active PCB

The Load Active PCB option controls whether the system loads a
PCB when you start the PCB Editor. When this option is on (the
default value), the system loads the PCB highlighted in the PCB
Layout box on the opening screen.

To load the active PCB when you start the PCB Editor

• Fill the Load Active PCB check box.

Using Design Rule Checking

The Online DRC option makes some features in the Design Rules
Check tool available while you use the PCB Editor. Before you use
Online DRC, you should be familiar with the Design Rules Check
tool. See Chapter 12, “Checking for Design Rules Violations.”

The Online DRC option controls whether the system checks for
spacing violations when you enter wires using Enter→Wire or
Edit→Enter Wire. When this option is on, the system checks for the
following spacing violations:

• pad-to-pad

• pad-to-trace

• trace-to-trace
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• pad-to-board-edge

• trace-to-board-edge

Pad-to-pad and pad-to-board-edge spacing checks are performed
when you enter a via. The system checks the spacing between the
pad through which you've entered the wire, and other pads and the
board's edge.

Pad-to-pad, pad-to-trace, and pad-to-board-edge spacing checks are
performed on flashes in padstacks or in SMT parts.

Note:  For the system to check for via or pad violations, the
padstacks must be attached to the database and the layers in the
padstacks specified in a check pass. Similarly, the aperture table
must be attached to the database and layers containing flashes must
be specified for the checks to work properly.

When any of the spacing violations occur, the system beeps,
highlights the violation, and describes it on the message line. You
can fix the cause of the violation, or enter the wire anyway.

The Online DRC option performs checks only for the wire being
entered. It doesn't, for example, check pad-to-board-edge spacing
when you move components. It doesn't check spacing between
wires and graphic (non net) data.

Note:  Online DRC only checks the bounding circle or rectangle of
THERMAL and SPECIAL flashes. It doesn't check TARGET flashes,
flash holes, or freestanding flashes created by Draw→Flash.

A number of features lets you control how the system checks for
violations.

• • You can use Edit Design Rules File to specify minimum spacing
values. The design rules file (.rul) is the same as it is in the
Design Rules Check tool. When you select Edit Design Rules
File, the screen in Figure 2-2 appears.

The last five settings show the default minimum spacing values.
(The first four settings are for information only. They can be
used later, when you use the Design Rules Check tool to check
the database.) Instructions for setting up new spacing rules are
in Chapter 12,  “Checking for Design Rules Violations.” If you
want to use the default values, don't alter this file.

• You can use Edit Check Pass File to set up check passes. The
check pass file (.pas) is also the same as it is in the Design
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Rules Check tool. When you select Edit Check Pass File, the

screen shown in Figure 2-3 appears.

Figure 2-2. Edit Design Rules File Screen

Figure 2-3. Edit Check Pass File instructions for setting up new
check passes are in Chapter 12,  “Checking for Design Rules
Violations.” If you want to use the default values, don't alter this file.
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Figure 2-3. Edit Check Pass File Screen

• A keyboard command, /drc (design rules check), also controls

whether the system checks for spacing violations. You can use
/drc to override the setting for the Online DRC option.

When the Online DRC option is off, the system doesn't check for
spacing violations.

To enable the Online DRC option

• Fill the Online DRC check box.

Displaying Verbose Warnings

Display Verbose Warnings provides you with a means of controlling
which warning messages you see. When this setting is enabled (the
default), the system displays all warnings. When this setting is
disabled, the system currently suppresses the following warnings:

New layers will be added. Continue?

Yes No

Force regen?

Yes No
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Autosave database?

Yes No

The first warning is displayed each time you load information using
File→Load Block or Enter→Component, and the incoming
information includes layers which aren't in the current layer table.

The second warning is displayed when you change a layer's visibility
status from OFF to ON or ABL, and the Use Display List option in
the Configuration screen is enabled. (See the previous section,
Using the Display List, for more information about the display list.)

The third prompt appears when you use AutoSave Interval on the
Editor Configuration screen to automatically save the database at
specified time intervals.

To display all warnings

• Fill the Display Verbose Warnings check box.

To suppress warnings

• Empty the Display Verbose Warnings check box.

Note:  If you use macro files created in or for versions prior to MD
8.0, the Display Verbose Warnings option must be enabled for the
macro to replay properly.

Displaying Dynamic Ratsnests

Dynamic Ratsnest Display lets you control the display of ratsnests
when the Enter→Wire command is active. When this feature is
enabled, the dynamic ratsnest display constantly updates to show
the shortest path from the cursor to the nearest unconnected
segment or pin in the net. If all pins in the net are already
connected, the dynamic ratsnest points to the nearest pin in the net.
By default, the system sets this option to ON.

To enable dynamic ratsnest display

• Fill the Dynamic Ratsnest Display check box.

To disable dynamic ratsnest display

• Empty the Dynamic Ratsnest Display check box.
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Loading a Function Key File

The Function Key File option automatically loads the set of function
key definitions saved in the file you specify. For example, if you
program 10 keys and use /pksv to save them in the file pcb1.key,
the keys are programmed automatically when you start the editor if
pcb1.key is in the Function Key File data entry box. (Functionally,
this configuration option is equivalent to using /pkld in the PCB
Editor.) If the file isn't in the current directory, include a directory
path to indicate its location.

To enter a default function key file

1. Select the Function Key File data entry box. A file selector box
appears, as shown in Figure 2-4.

2. Select the filename you want in the list box.

3. If the file isn't listed because it's not in the current directory, type
the filename and full path name of the function key file in the
data entry box.

4. Select OK.

Figure 2-4. Function Key File Selector Box
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Setting the Pin Size

The Pin Size option specifies the default display size for pins in the
database. In the PCB and Part Editors, pin graphics will be displayed
at the size specified unless padstacks have been attached (in the
PCB Editor). The range is 4 to 100. The default is 40.

To enter a default pin size

1. Select the Pin Size data entry box.

2. Enter the value.

Setting the Via Size

The Via Size option determines the default display size of vias in the
database. In the PCB and Part Editors, via graphics are displayed at
the size specified unless padstacks have been attached (in the PCB
Editor). The range is 4 to 100. The default is 40.

To enter a default via size

1. Select the Via Size data entry box.

2. Enter the value.

Setting the Flash Size

The Flash Size option determines the size of flashes in the PCB
Editor when the aperture table or padstacks are not attached. It also
determines the default display size of flashes in the Part Editor. The
range is 5 to 150. The default is 60.

Note:  You define the actual shape, size, and rotation of flashes  in
the Aperture Table Editor. After you attach the aperture table to the
PCB editor, flashes will be displayed as they will look on the penplot.

To enter a default flash size

1. Select the Flash Size data entry box.

2. Enter the value.
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Setting the AutoSave Options

You can automatically save your design using one of three options

• the autosave interval

• the autosave extension

• the autosave archive

When you click AutoSave Configuration at the Editor Configuration
screen, the system displays the AutoSave Configuration dialog box,
shown in Figure 2-5.

Figure 2-5. Autosave Configuration Dialog Box

Setting the AutoSave Interval

The AutoSave Interval option determines how many minutes pass
before the system prompts you to save the database. The prompt
appears only if you've made a change to the database during the
AutoSave Interval. (Display Verbose Warnings must also be on for
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this prompt to appear.) For example, if the AutoSave Interval is set
to 30, each time 30 minutes pass the system waits until you select
the next command, then displays the following prompt:

Autosave database?

You can select Yes to save the database or No to continue without
saving the database.

Caution:  Unless you specify an AutoSave filename extension, the

AutoSave Interval overwrites your file and doesn't save a backup file
of the previous version. Before you use the AutoSave Interval option
to save a file, you should save a backup file by copying the original
file to one with a different name.

The number of minutes you can specify for AutoSave Interval is 0 to
1000. If you specify 0, the AutoSave Interval is disabled. The default
is 30.

To enter the number of minutes that pass before the system
prompts you to save the database

1. Click the AutoSave Configuration button. The system displays
the AutoSave Configuration dialog box.

2. Select the AutoSave Interval data entry box.

3. Enter the number of minutes you want to wait between saves.

4. Click EXIT to return to the Editor Configuration screen.

Setting the AutoSave Extension

If you specify an AutoSave filename extension, at each AutoSave
interval your database will be automatically saved in a temporary file
with the current database filename and a specified extension. Your
original database will not be overwritten until you select File→Save.

To create the AutoSave file

1. Click the AutoSave Configuration button. The system displays
the AutoSave Configuration dialog box.

2. Set the AutoSave interval.

3. Enter the AutoSave filename extension.

4. Save the configuration.

5. When the first AutoSave interval occurs, the program will
prompt
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Autosave database?

Select Yes to save your current workfile to the AutoSave file.

If you don't want an AutoSave file, delete the filename extension by
using . If there is no AutoSave filename extension, AutoSave will
overwrite the original database file at each interval. When you select
File→Save, your changes are saved to the database file, and the
AutoSave file is deleted.

Note:  You should still save a backup of your original file, as noted
in Setting the AutoSave Interval.

Setting the AutoSave Archive

The Auto-Save Archive option indicates how many archive files are
automatically saved during the current editing session. You can
enter a number between 1 and 99 to specify the number of archived
files. When you enter a number, the system grays out the Auto-Save
Extension field since this extension is not needed.

For each archived file, the extension is ``.pNN", where NN is a
number between 1 and the archive number you specified. The
system always saves the most recent archive file with a ``.p01"
extension. During an autosave, the system deletes the highest
numbered archive, renumbers the archived files, then saves the
latest archive. For example, if you set Auto-Save Archive to 3, then
during an autosave, the system deletes the archive file with the
``.p03" extension, renames the ``.p02" file to a ``.p03" file, renames
the ``.p01" file to a ``.p02" file, then saves the latest archive with a
``.p01" extension.

After the current editing session, the system leave any remaining
archive files on disk for you to handle as you see fit.

To set the Auto-Save Archive

1. Click the AutoSave Configuration button. The system displays
the AutoSave Configuration dialog box.

2. Select the Auto-Save Archive field. The system prompts

Enter The Number of Backup Files to Archive

3. Enter the desired number of archive files. The default is 0.

4. Click EXIT to return to the Editor Configuration screen.

Caution:  The Auto-Save Archive option applies to both PCB Editor

and Part Editor files. This means that if you have a PCB file and a
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part file with the same name, the system will overwrite the archives
for each. For example, if you archive a PCB file called
component.pcb, then open a part file called component.prt, the
system overwrites the PCB file archives with the part file archives.
To prevent this, we recommend that you keep your PCB and part
filenames unique.

Saving and Copying Default Editor Configuration Values

When you are in the Editor Configuration screen, the Copy Default
button will copy a cards.cfg default configuration file to the current
directory, and the Save Default button will save any changes you
have made back to that default configuration file. PCAD allows you
to access this file from any directory. This cards.cfg file is in the
directory specified in the PCAD_CFG variable.

To take advantage of this feature, you need to set the environment
variable, PCAD_CFG, in your autoexec.bat file. Instructions for
setting the variable are in the Setting Up Access to Default Editor
Configuration Files section of the Getting Started manual.

To save the current configuration settings to the default editor
configuration file

1. Select the Save Defaults button.

To copy the settings from the default editor configuration file

1. Select the Copy Defaults button.

Closing the Editor Configuration Screen

After you've made the changes in the Editor Configuration screen,
selecting EXIT will save them as cards.cfg in the current working
directory. The PCB Editor reads this file when it is invoked.

To close the Editor Configuration screen and save the changes

• Select EXIT.

To close the Editor Configuration screen without saving any
changes

Select CANCEL.
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Setting the PCB Editor Environment 3
Some preparation is needed before you use the PCB Editor. This
chapter discusses that preparation. It talks about

• what to consider before you begin a PCB layout

• what to do outside the editor to define the design directory and
files, define the part libraries, extract parts from libraries, and
configure the editor

• what to do inside the editor to set the grid, the units of measure
(English or metric), and the layer structure

What You Need to Consider

Before you begin a PCB design, you need to

• Determine the design rules that must be applied to the PCB.

• Determine pad geometries and sizes and, if film is to be
generated by photoplotting, determine the appropriate apertures.

• Define the apertures to be used in padstacks, as well as to draw
other board geometries by using the Aperture Table Editor
(either the standalone ATE or from the Part Editor). For
information on defining apertures, see the “Using the Aperture
Table Editor” chapter in this manual.

• Create the padstacks necessary to define the component pads.

• Decide whether you need to create any library parts. (The
system comes with a comprehensive set of standard library
parts.) If you need to create parts, see the chapters on “Using
the Part Editor Commands” and “Using the Part Editor” in the
Library Manager manual.
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Creating a Database Template

If you have frequently used environmental settings, you can create a
template.pcb file which you can use to start each new PCB layout.
Using the template file will save you the work of recreating the same
basic environment for each new layout. PCAD supplies a sample
template file, template.pcb, located in the same directory as the
executable files. You can change template.pcb to suit your needs,
but don't change the location of the file.

If you add a new PCB layout filename to your design in Design
Manager before you open the PCB Editor, the system uses
template.pcb to set the environment for this new layout database. If
you open the PCB Editor when the PCB Layout list box is empty, the
system uses template.pcb to set the default environment.

What to Do Outside the PCB and Part Editors

Before you create a PCB design or a part, you must perform the
following tasks in other PCAD tools:

• Use the Design Maintenance tool to create your design directory

and add the PCB layout file.

• Make sure the design directory and PCB file you're using are
defined in the Design Manager module. If they're not, use the
Design Maintenance tool to define them. (See the Design
Manager manual for information on how to define the design

directory and PCB file.)

• If  the PCB Editor isn't the sole tool you're using to create the

PCB database, complete the process of using tools outside the
editor to generate the PCB database. For example, use
Schematic Tools to create and package a schematic.

• Use the Aperture Table Editor to define the apertures to be used

in padstacks as well to draw other graphic entities on your board
such as traces and polygon borders. For information on using
the Aperture Table Editor (ATE) tool, refer to Chapter 5 in this
manual.

• Use the Set Libs. & Search Paths tool in the Library Manager

module to list the paths and library names of any libraries you'll
use. The PCB Editor searches these libraries when you use



Setting the PCB Editor Environment

PCB Tools 37

Enter→Component or Enter→Replace Component. See the
chapter on setting libraries and paths in the Library Manager
manual.

• If you want to edit a copy of an existing part, you must extract
the part from an archived library by using the Library
Maintenance tool. See the chapter on maintaining libraries in the
Library Manager manual.

• Use the Editor Configuration tool in the PCB Tools module to set

values used by the PCB Editor. See Chapter 2 in this manual.

What to Do Inside the PCB Editor

Before you create a PCB, you must set the environment inside the
PCB Editor. Setting the environment involves

• setting the grid

• setting the units of measure (English or
metric)

• setting up a layer structure

Setting the Grid

The PCB Editor grid consists of equidistant points arranged in an
orthogonal (X and Y) coordinate system. The basic unit of measure
in PCAD is the database unit (DBU). You can set the DBU to either
English (US) or metric units.

• In English units, each DBU is equal to 1 mil (.001I) on a 1:1
scale. One-thousand DBUs equal one inch. The default grid
setting of 50 by 50 DBUs represents a grid of 50 by 50 mils.

• In metric units, each DBU is equal to .01 millimeter (mm) on a
1:1 scale. The default grid setting of 50 by 50 DBUs represents
a grid of .5 by .5 mm.

The system also supports submil resolution. In PCAD, submil
resolution refers to a fraction of a DBU. In English units, you can use
submil resolution as fine as 1 one-hundredth of a mil (.00001I). In
metric units, you can use resolution as fine as 1 ten-thousandth of a
millimeter (.00001 mm).
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When you use submil resolution, you should be aware that most
photoplotters support four digits of resolution (one-tenth of a mil,
.0001), but not five digits of resolution (one-hundredth of a mil
.00001). If you use five digits of resolution in your database, and
photoplot it on a device that doesn't support five digits after the
decimal, the coordinates are truncated to the number of digits the
device supports.

You can change the grid by using the grid options shown in
Figure 3-1. The grid options are

• changing the grid spacing

• showing the grid

• snapping the cursor to the grid

• moving the cursor by entering a specific
coordinate

Figure 3-1. Grid Options in the Status Area

Changing the Grid Spacing

The grid option in the status area, displayed as Grd: 50:50 by
default, controls the spacing between grid points.

To change the grid spacing
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1. Select the Grd field. The system
prompts

 Enter x grid size:

2. Enter the spacing you want in the horizontal
dimension. The system prompts

 Enter y grid size:

3. Enter the spacing you want in the vertical
dimension.

Note:  You can combine steps 2 and 3. After the system prompts
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

you to enter the X grid size, type the spacing you want in the
horizontal dimension, leave a space, type the spacing you want in
the vertical dimension, and press ↵.

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Showing the Grid

The show grid option (ShwGrd) uses a check box to toggle the grid
on and off. Turning on the grid means you can see the dots
representing the grid on your screen. If you turn off the grid, no dots
appear. You may not see the grid even if the grid is on because of
the zoom scale.

To turn the grid display on and off

• Fill the ShwGrd check box in the status area. The box appears
filled if ShwGrd is on. The box appears empty if ShwGrd is off.
The default is on.

Note:  If you use the default set of function keys, F7 toggles ShwGrd
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Snapping the Cursor to the Grid

The snap-to-grid option (SnpGrd) determines whether the cursor is
forced to a grid point when entering data. When SnpGrd is on, the
cursor can go only from grid point to grid point. When it's off, the
cursor can move anywhere between the points. Generally, you'll
want this feature on. If you turn it off, it's difficult to line up
components and wires correctly.

To turn the snap to grid feature on and off

1. Fill the SnpGrd check box in the status area. The box appears
filled if SnpGrd is on. The box appears empty if SnpGrd is off.
The default is on.
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Note:  If you use the default set of function keys, F8 toggles SnpGrd
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

on and off.
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

Moving the Cursor by Using a Specific Coordinate

The option on the lower right side of the status area shows the
cursor position on the grid. The first number is the cursor's location
on the X axis; the second is its location on the Y axis. You can select
this option to move the cursor anywhere on the grid.

To move the cursor to a specific coordinate

1. Select Pan on the view command line. Pan changes the view so
you'll see the new cursor location.

2. Select the XY option in the status area. The system prompts

Enter X position:

3. Enter the X coordinate of the location where you want the
cursor. The system prompts

Enter Y position:

4. Enter the Y coordinate of the location where you want the
cursor. The cursor moves to the location you specified. The
coordinates of the location appear in the grid location field.

Note:  You can also save and recall the position of the cursor in the
graphics area. To save the cursor position, locate the cursor at the
point you want saved, then enter /scp (save cursor position). To
recall the cursor to its saved position, enter /rcp (recall cursor
position). This method of saving the cursor's position is useful if you
use the keyboard instead of the mouse to manipulate data, and you
frequently move between the status area and graphics area. The
/scp command is also the default function for F9. The /rcp command
is the default function for F10.

Setting the Units of Measure: English or
Metric

You can set your units of measure to English or metric. You must
set the units before you enter an intelligent object, such as a
component or wire, in the PCB design. However, you can enter
components that use one unit of measure in a design that uses
another. The system converts the component's unit of measure to
match the unit of measure in the PCB. Each English unit equals
.0254 metric units. All coordinates, sizes, and widths are multiplied
by .0254 when they're changed from English to metric units. When
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they're changed from metric to English units, they're divided by
.0254.

To set the units of measure

• Select Environment→Change Units. This command toggles
between English and metric. The default is English.

Setting Up a Layer Structure

Layers separate PCB data so that you can selectively view, edit, and
plot portions of your design. Layers are analogous to clear plastic
sheets stacked on top of each other to form a complete drawing.
Each layer represents one clear plastic sheet. Some of the layers
are the same as the physical layers of the PCB. Other layers serve
special uses unique to the editor. For example, the BRDOUT layer is
used by placement commands and Autorouter tools; the PINTOP
and SLKTOP layers are used for SMD parts.

The system comes with a set of default layers. Don't destroy the
defaults. Some modules and tools look for data by the default layer
name. For example, the Autorouter tool looks for the board outline
on the BRDOUT layer. You can create new layers in addition to the
default layers.

The default layers for the PCB Editor are shown in Table 3-1.

Table 3-1.  The Default Layers
Layer Name Function

PADCOM Graphic component-side padstack layer

FLCOMP Photoflash component-side padstack layer

PADSLD Graphic solder-side padstack layer

FLSLD Photoflash solder padstack layer

PADINT Graphic internal padstack layer

FLINT Photoflash internal padstack layer

GNDCON Graphic ground connection  padstack layer

FLGCON Photoflash ground connection padstack layer

CLEAR Graphic clearance padstack layer

FLCLER Photoflash clearance padstack layer

PWRCON Graphic power connection  padstack layer

FLPCON Photoflash power connection padstack layer

SLDMSK Graphic solder mask padstack layer

FLSMSK Photoflash solder mask padstack layer

DRILL Graphic drill legend padstack layer

FLDRLL Photoflash drill legend padstack layer

PIN Graphic component pin layer

BRDOUT Board outline layer used by Placement and
Autorouter tools

FLTARG Photoflash reduction target layer
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SLKSCR Graphic silkscreen layer for through-hole
parts

DEVICE Graphic device name layer

ATTR Attribute layer

REFDES Reference designator layer

COMP Component-side trace layer

SOLDER Solder-side trace layer

INT1 Internal trace layer

INT2 Internal trace layer

DRLGIN Graphic internal drill legend padstack layer

DRLFIN Photoflash internal drill legend padstack layer

PINTOP Graphic top-surface pin layer, for SMD
devices

PINBOT Graphic bottom-surface pin layer, for SMD
devices

MSKGTP Graphic top-surface solder mask layer, for
SMD devices

MSKGBT Graphic bottom-surface solder mask layer, for
SMD devices

MSKFTP Photoflash top-surface solder mask layer, for
SMD devices

MSKFBT Photoflash bottom-surface solder mask layer,
for SMD devices

PSTGTP Graphic top-surface solder paste layer, for
SMD devices

PSTGBT Graphic bottom-surface solder paste layer, for
SMD devices

PSTFTP Photoflash top-surface solder paste layer, for
SMD devices

PSTFBT Photoflash bottom-surface solder paste layer,
for SMD devices

SLKTOP Graphic top-surface silkscreen legend layer,
for SMD devices

SLKBOT Graphic bottom-surface silkscreen legend
layer, for SMD devices

DVCTOP Top-surface device name layer, for SMD
devices

DVCBOT Bottom-surface device name layer, for SMD
devices

REFDTP Top-surface reference designator layer, for
SMD devices

REFDBT Bottom-surface reference designator layer, for
SMD devices

PINFTP Photoflash top-surface land layer, for SMD
devices

PINFBT Photoflash bottom-surface land layer, for
SMD

devices

Setting up a layer structure is a main step in creating an
environment for a PCB design. You can set up this structure in one
of two ways:
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• by using the layer structure from an existing database

• by creating a new layer structure with the View Layer screen

To set up a layer structure from an existing database

1. Load an existing file (filename.pcb) containing the layer structure
you want.

2. Use File→Clear Database to clear the display.

To create a new layer structure

1. Select View Layer on the view command line.

2. Toggle the values in the View Layer screen, shown in
Figure 3-2. The values are discussed in detail in the following
sections.

Figure 3-2. View Layer Screen

In the View Layer screen, each layer is followed by three fields
of information that show the

• color of the layer in a range of numbers from 1 to 15 in the first
field

visibility status of the layer in the second field

• active layer designation (A) in the third field
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You can alter a layer structure by

• changing a layer's color

• changing a layer's status

• changing the active layer

• changing the name of a layer

• creating a new layer

Note:  If you make changes to the View Layer screen, the changes
are saved when you save the database. To revert to the previous
layer structure, you load the old database.

Changing a Layer's Color

The first field after the layer name shows the layer color. Up to 15
colors are available. You can use the numbers in that column to
assign plotter pen positions.

To change a color on a layer

1. Select View Layer on the view command line.

2. Select the color number. A range of color code numbers
appears toward the bottom of the screen.

3. Select the number of the new color you want.

4. To change additional layer colors, repeat steps 2 and 3.

5. To return to the editor screen, select EXIT.

Changing a Layer's Status

The second field to the right of the layer name shows the layer's
status. The status gives you the flexibility to turn layers on and off
for selective viewing, editing, and plotting.

The ABL status controls the layers you cycle through from the status
area. The system cycles through layers with the ABL status when
you select the layer name option on the status line or press F1. The
layer displayed becomes the current or active (A) layer. You can't
cycle through layers with an OFF or ON status from the status area
and, therefore, can't activate them this way.  shows what each layer
status means.
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Table 3-2.  Layer Status
Status Effect on Data

OFF Data is not visible and can't be edited.*

ON Data is visible and can be edited. This layer isn't available

to become the current layer on which you enter data. If

you click the ON=Read Only check box, you cannot edit

the data on this layer.

ABL Data is visible and can be edited. This layer is available to

become the current layer on which you enter data.

* However, all components are affected when you use the Move, Rotate,

and Delete commands.

You can change the status of one layer or several layers at a time
any one of the following ways:

• By cycling through the status options for each desired layer.

• By using the keyboard commands /ofly, /only, /lyrn, and /ably.

• By using the View Layer screen buttons Off Layer, On Layer,
and Abl Layer located on the View layer screen. These buttons
work the same way as the commands /ofly, /only, and /ably,

respectively.

• By clicking the ON=ReadOnly check box to set all layers with
the ON status to be reference layers.

To change the status of a layer

1. Select View Layer on the view command line. The status options
appear in the View Layer screen.

2. Select the status of the layer you want to change.

3. Click left until the option you want appears.

or

Select Off Layer, On Layer, or Abl Layer and enter a layer name
or name pattern.

4. To return to the editor screen, select EXIT.
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To change the status of a layer using the keyboard commands

1. Enter the desired keyboard command /ably, /ofly, or /only. The
response area prompts

Enter layer name (* for all layers):

2. Enter the name of any layer except the active layer.

Or you can enter an asterisk (*) for all layers.

When entering the name of a layer, you can enter a search
pattern with a wildcard character. For example, the pattern ATT*
selects all layers whose names begin with the letters ATT.

After you make your selection, the system redraws the screen to
show any layer status changes.

Note:  If you enter a question mark (?) instead of an asterisk (*) in
the search pattern, the system selects only the first layer in the list
that matches the search pattern. For example, the pattern ATT?
selects only the first layer whose name begins with the letters ATT,
in this case ATTR.

You can set all layers that are set to ON to be reference layers.
When you do this, the system disables all editing commands for
these layers. You can display information about objects on the
reference layers, but you can't edit or manipulate the objects
themselves. However, if you delete a net that has a read-only layer,
Master Designer treats the read-only layers as OFF layers and
deletes their contents. This rule applies to the Delete→Object and

Delete→Window commands.

To change ON layers to read-only

1. Select View Layer on the view command line. The View Layer
screen appears.

2. Select ON=ReadOnly. The system sets all layers with the ON
status to read-only.

3. Select EXIT.

You can remove the read-only status from the ON layers by
deselecting the ON=ReadOnly check box.

Changing the Active Layer

The last field in the View Layer screen shows the active (A) layer.
This is the layer you're currently editing. You can activate a layer in
one of two ways:
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• You can enter the keyboard command /alyr from the editor

screen.

• You can use the View Layer screen.

To activate a layer with an OFF or ON status

1. Type / to execute a keyboard command. The system prompts

 Menu command:

2. Enter alyr. The system prompts

 Enter layer name:

3. Enter the name of the layer you want active.

To activate a layer by using the View Layer screen

1. Select View Layer on the view command line.

2. Move the cursor to the third field following the layer name.

3. Move the box to the layer you want active.

4. Select the layer. An A appears in this field to indicate that the
layer is active.

5. To return to the editor screen, select EXIT.

Changing the Name of a Layer

You can change the name of a layer, but remember—some PCAD
tools look for data by the default layer name.

To edit the name of an existing layer

1. Select View Layer on the view command line.

2. Select the layer name you want to change. The system prompts

Enter New Name:

The old layer name appears after the prompt. You can edit the
old layer name by using the buttons on the mouse or by using
←, →, Ins, Backspace, and Del.

3. Type in the new name or edit the old name by using ←, →, Ins,
Backspace, and Del, and then press ↵.

4. To return to the editor screen, select EXIT.

Creating a New Layer
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In addition to using the layers supplied by PCAD, you can create
new layers. You can have up to 100 layers, displayed in four
columns of 25.

To create a new layer

1. Select View Layer on the view command line.

2. Select Add Layer in the status area. The system

prompts

Enter New Name:

3. Enter the name you want. The system displays a submenu of 15
colors. The color of the number is the display color. The number
refers to the pen number when you penplot the layer.

4. Select a color. The system displays the options.

5. Select a status for the layer. The new layer appears at the
bottom of the list of layers.

6. To return to the editor screen, select EXIT.

Setting the Menu Display

The Menu cycle button offers three options for the menus in the
graphic editors—pulldown menus, menus off, and button menus.

• MnPul gives you the regular pulldown menus. Select a menu

command  and hold the mouse button while you select the
submenu command. In DOS, you can release the mouse button,
and the submenu stays up until you make a selection.

• MnOff turns off the sidebar menu, giving you the full screen

width for design work. To activate a pop-up menu, press the
third (right) button while the cursor is in the drawing area.

• MnBtn allows you to work with one submenu. When you select a

main menu command, the submenu appears on the sidebar,
covering the main menu. To return to the main menu, select
Main Menu.

To set the menu display
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Use the Menu cycle box or the keyboard command /menu to select
your preferred menu.
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Using the PCB Editor Commands 4
The PCB Editor is driven by commands. To use the editor, you need
to know the

• menu commands

• view command line

• keyboard commands

Menu Commands

The PCB Editor contains a sidebar menu with top-level commands.
When you select one of these commands from the menu area, a
sub-menu appears. If you press mouse button 3 when the cursor is
in the drawing area, a popup menu appears. (If you have a 2-buton
mouse, press Ctrl  and button 2.)

The top-level commands that activate menus in the PCB Editor are

• File

• Query

• Enter

• Draw

• Name

• Edit

• Move

• Rotate

• Copy

• Delete

• Chg. Layer

• Crit. Path
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• Group

• Dimension

• Swap

• Align

• Placement

• Improve Plc

• Environment

• Display

The menus are discussed in this chapter. For detailed explanations
of the individual menu commands, see the Command Reference
manual.

Figure 4-1 shows a menu tree of the top-level PCB Editor
commands.
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Save
Load
Plot
Save Block
Load Block
Clear Db.
Level Push
Print
Quit

File

Text
Line
Rectangle
Filled
Circle
Filled Circle
2 Pt. Arc
3 Pt. Arc
Polygon
Flash
Circ. Void
Poly. Void

Draw

Move All
Wire
Add Vertex
Move Vertex
Del. Vertex
Attribute
Trace
Undo
Add Via
Move Via
Delete Via
Seg. Layer
Mov Segment
Del Segment
Trace Width
Keyword
Net Attr

Edit

Wire
Ratsnest
Componen
Uncomm. Pin
Attribute
Repl. Comp
Origin
Polygon

Ente
r

Object
Net
Net
Componen
Pin
Vi
Trace
Net
Polygo
Poly
Crit.
Grou
Padstac
Aperture
Propertie

Query

Net
Subnet
Component
Reseq Refd.
Reseq Wind.

Name
Object
Objects
Window
Component
Attribute
Undo
Crit. Path
Group

Move
Object
Objects
Window
Trace

Copy
Object
Objects
Window
Component
Attribute

Chg.
Layer

Object
Objects
Window
Component
Undo

Rotate
Object
Objects
Window
Attribute
Trace
Undo

Delete
Add Gate
Remove Gate
Change Name
Break Link
Remove Def.

Crit. Path

Add Gate
Remove Gate
Change Name
Remove Def.

Group
Component
Pin
Gate
Undo

Swap

Dimension

Configure
Point
Datum
Leader
Center One
Center
Diameter
Radius
Angular
Adjust
Bind
Unbind

Figure 4-1. The Menu Tree
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Store View
Recall View
Long Pan
PthGrp Vis.
Ctrl Rats.
Measure

DisplayEnvironment

DOS Shell (DOS only)
Change Unit
Statistics
Snap Tol.
Attach Pads
Mask Items
Layer Pairs
Void Merge
Min PolySiz
Min PolyClr
Inr Pln Apr
Set Min Apr
Aper. Table
Clear Flash
Min FlshClr

Objects
Window
Component
Undo

Align Placement

Spacing
Def. Comps
Clearances
Association
Barriers
Cutlines
Fix
Unfix
Autoplace
Histogram

t

t

Enter
Delete

Barriers
Window
Component

Fix

Window
Component

Unfix

Configure
Grid
Gen. Stats
Reset Merit

Histogram

Component
Gate

Improve Plc

t

Figure 4-1. The Menu Tree (cont’d)

File Menu

The File menu consists of commands that transfer files to and from
the editor. The File menu commands are as follows:

• Save writes the PCB database to a file on the disk.

• Load brings a PCB database file into the editor.

• Create Plot File allows you to define an area of the database

that you want to plot. The plot file is in a binary format that can
be printed, pen-plotted, or photoplotted with the Hardcopy tool.
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• Save Block saves an area of the database in a separate file.

You can load this block into another PCB database by using the
Load Block command.

• Load Block places a previously saved block of another database

in the current design.

• Clear Database closes the current display and erases the

database from memory, except for the layer structure, grid
settings, and units. It also detaches the aperture table from the
database.

• Level Push lets you edit a part while you're working on a

database. Changes you make affect only the part in the current
directory, not the part in the library.

• Print prints an ASCII (text) file.

• Quit takes you out of the PCB Editor.

Query Menu

The Query menu contains commands that display information about
selected objects. Query commands can also be used to edit objects
and change their values. An object is a wire, a line, text, a circle, an
arc, a polygon, or a flash. The Query menu commands are as
follows:

• Object displays information about an object. You can use this

command to change the width of lines, traces, circles, and arcs.
Properties of polygons or flashes can also be changed.

• Net displays the net name, the net type, and the number of pins

of a net you select.

• Trace displays the length between two points you select on a

trace. It also displays the net name.

• Component displays the selected component's reference

designator,  filename, component type, and rotation angle. If the
component is an SMD, the side of the board the component is
on (top or bottom) is also displayed.

• Pin displays the pin name, pin type, logical equivalence, and

owning net name.
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• Net Pins changes pin types within a selected net.

• Via displays the via type and owning net. You can use this

command to change a via type.

• Net Vias changes through-hole via types within a selected net.

• Padstack tells you which padstack is attached to a pin or via and

displays descriptive information about the padstack.

• Polygon checks a selected polygon to determine if it will be

photoplotted correctly. If it won't, you can let the system fix it or
use the PCB Editor to fix it yourself.

• Polygon Window checks the polygons in a window you select to

determine if they'll be photoplotted correctly. If they won't, you
can let the system fix them or use the PCB Editor to fix them
yourself.

• Critical Path highlights the connecting gates of the critical path
and shows the path name.

• Group highlights the connecting gates of the group and shows

the group name.

• Apertures displays information about flash apertures used in the
current database. The apertures report is also saved to a file
that you can print with  File!Print.

• Properties  lets you view and change the properties for any

selectable object, component, or attribute.

Enter Menu

The Enter menu contains commands that allow you to add intelligent
information (wire, component, ratsnest, polygon) to the PCB
database. Intelligent information refers to entities that have electrical
meaning. Other commands on the Enter menu let you add attributes
and a board origin, remove a pin from a net, and replace
components. The Enter menu commands are as follows:

• Wire enters traces in a PCB.

• Component adds components to a design. A component is also
called a part. A part contains the lead pattern, silkscreen
graphics, and packaging information.
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• Attribute adds an attribute to a PCB database. An attribute is
textual information associated with a component in a PCB
database. With this command, you can enter component
attributes.

• Ratsnest adds nets to a PCB database.

• Polygon creates filled or hatched areas with net intelligence to
represent copper planes.

• Board Origin adds a datum or reference point used by the Drill
tool.

• Uncommit Pin removes a pin from a net.

• Replace Component replaces components.

Draw Menu

The Draw menu contains commands you use to create graphics and
text. Graphics created with the Draw commands don't have
intelligence or net associations in the PCB database. The Draw
menu commands are as follows:

• Text adds text to the database.

• Line adds lines to the database.

• Rectangle adds rectangles to the database.

• Filled Rectangle creates solid-filled rectangles.

• Circle creates circles defined by a center point and a point on
the radius.

• Filled Circle creates solid-filled circles.

• 2-Point Arc creates arcs defined by a center point, a start point,
and an end point.

• 3-Point Arc creates arcs defined by a start point, an end point,
and a radius.

• Polygon creates irregular-shaped filled areas without net or
signal associations.
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• Circular Void creates entities used to remove a circular area in a
polygon.

• Polygonal Void creates irregular-shaped entities used to remove
an area in a polygon.

• Flash draws the actual shape, size, and rotation of most flash
apertures based on their definitions in the attached aperture
table. If no table is attached, the flash will be drawn using the
default flash size specified in the editor configuration.

Name Menu

The Name menu contains commands that assign and edit a
component, net, or subnet name. It also contains two commands
that resequence reference designators. The Name menu commands
are as follows:

• Component extracts the reference designator from a component

and makes the text visible or assigns reference designators to
unnamed components. This command also lets you remove a
reference designator from a component.

• Net displays the net name for a net or trace or assigns a net

name to a net or trace.

• Subnet assigns a different net name to a wire or trace already

named.

• Reseq. Ref. Des. resequences reference designators.

• Reseq. Window resequences reference designators or unnamed

components in a window you select.

Edit Menu

The Edit menu contains commands you use to enter and manipulate
wires and vias. The Edit menu commands are as follows:

• Move All changes the location of the selected wire segment, as

well as any vias and wire segments attached to the vertices of
the selected segment.

• Enter Wire adds a trace to a PCB database.

• Add Vertex creates a vertex in an existing trace or line.
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• Move Vertex changes the position of a vertex in a wire or line

segment.

• Delete Vertex removes a vertex from a wire or line.

• Move Segment changes the position of a wire or line segment.

• Delete Segment removes a wire or line segment.

• Undo Delete Segment restores a wire or line segment previously
deleted with the Delete Segment command.

• Add Via creates a feedthrough or interstitial via at the vertex of

a trace.

• Move Via repositions a feedthrough or interstitial via.

• Delete Via removes a via from the PCB database.

• Segment Layer changes the layer on which a trace is located.

• Delete Trace deletes the portion of a wire between two points

you select.

• Trace Width changes the width of a trace between two points

you select.

• Attribute displays an attribute and its keyword so you can

change the value. An attribute is textual information associated
with a component in a PCB database. With this command, you
can edit component attributes.

• Keyword displays an attribute and its keyword so you can

change the keyword.

• Net Attribute lets you add, modify, or delete net attributes.

Move Menu

The Move menu contains commands that change the location of
attributes, critical paths, groups, components, and objects. An object
is a component, wire, line, or circle, an arc, or text. The Move menu
commands are as follows:

• Object moves one object.

• Objects moves one or more objects.

• Window moves all objects inside a specified rectangular area of

the displayed view.
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• Component moves a component.

• Attribute moves an attribute.

• Critical Path moves a critical path. A critical path consists of

gates that are visually connected to show the flow of a signal
from one gate to another. Critical paths are used in high
frequency circuits, where you need to maintain high
performance by reducing signal trace delays, and in analog
designs, where you need to cut down noise pickup.

• Group moves a group. A group is a set of visually connected

gates that needs to be associated with other gates in the group.
Like critical paths, groups are used in high frequency circuits,
where you need to maintain high performance by reducing
signal trace delays, and in analog designs, where you need to
cut down noise pickup.

• Undo moves attributes, critical paths, groups, components, and

objects back to their original location before the last Move
command.

Rotate Menu

The Rotate menu contains commands that change the orientation of
objects and components. An object is a component, wire, line, or
circle, a flash, an arc, or text. The Rotate menu commands are as
follows:

• Object rotates one object.

• Objects rotates one or more objects.

• Window rotates all objects inside a specified rectangular area of
the displayed view.

• Component rotates a component.

• Undo rotates components and objects back to their original
orientation before the last Rotate command.

Copy Menu

The Copy menu contains commands that copy objects. The Copy
menu commands are as follows:



Using the PCB Editor Commands

PCB Tools 61

• Object copies one object.

• Objects copies one or more objects.

• Window copies all objects inside a specified rectangular area of
the displayed view.

• Trace copies a portion of a wire.

Delete Menu

The Delete menu contains commands that erase objects, portions of
traces, and attributes. It also contains an Undo command to let you
restore items you deleted. The Delete menu commands are as
follows:

• Object erases one object.

• Objects erases one or more objects.

• Window erases all objects inside a specified rectangular area of
the displayed view.

• Trace deletes the portion of a wire between two points you
select.

• Attribute erases an attribute assigned to a component.

• Undo brings back the last erased attribute or objects before
deleting another attribute or object.

Chg. Layer Menu

The Chg. Layer menu contains commands that modify the layer of
objects and attributes. The Chg. Layer menu commands are as
follows:

• Object changes the layer of one object.

• Objects changes the layer of one or more objects.

• Window changes the layer of all objects inside a specified
rectangular area of the displayed view.

• Attribute changes the layer of an attribute assigned to a
component.
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• Component moves a component to the opposite side of the
board. (If the component is on the top, this command moves it
to the bottom. If a component is on the bottom, this command
moves it to the top.)

Crit. Path Menu

The Critical Path menu contains commands that create, edit, and
disband a critical path. A critical path consists of a set of gates that
are visually connected to show the flow of a signal from one gate to
another. Critical paths are used in high frequency circuits, where you
need to maintain high performance by reducing signal trace delays,
and in analog designs, where you need to cut down noise pickup.
The Critical Path menu commands are as follows:

• Add Gate adds a gate to a critical path.

• Remove Gate removes a gate from a critical path.

• Change Name changes the name of a critical path.

• Break Link breaks a link between two gates in a critical path.

• Remove Definition disbands a critical path.

Group Menu

The Group menu contains commands that create, edit, and disband
a group. A group is a set of visually connected gates that needs to
be associated with other gates in the group. Like critical paths,
groups are used in high frequency circuits, where you need to
maintain high performance by reducing signal trace delays, and in
analog designs, where you need to cut down noise pickup. The
Group menu commands are as follows:

• Add Gate adds a gate to a group.

• Remove Gate removes a gate from a group.

• Change Name changes the name of a group.

• Remove Definition disbands a group.
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Dimension Menu

The Dimension menu contains commands that let you add
dimensioning data to the database. For a discussion of
dimensioning, see Chapter 7, "Dimensioning." The Dimension menu
commands are as follows:

• Configure sets values that determine how dimensioning

information is displayed.

• Point measures the distance between two points.

• Datum measures a series of points from a common origin.

• Leader adds a thin solid line that lets you place text away from

the object you're dimensioning.

• Center One marks the center of a circle or an arc.

• Center All marks the center of all circles or arcs on a specified

layer.

• Diameter measures the diameter of a circle or an arc.

• Radius measures the radius of a circle or an arc.

• Angular measures angles between intersecting lines.

• Adjust adjusts a dimension to reflect a change in the size or

location of an item.

• Bind groups items displaying dimensioning information together.

The system treats the grouped items as one object.

• Unbind releases dimensioning information into individual items

so you can edit the items separately.
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Swap Menu

The Swap menu contains commands you use to swap components,
gates, and pins. It also contains a command that undoes the most
recent swap. The Swap menu commands are as follows:

• Component swaps a component with any other component.

• Gate swaps gates of the same type from one position to another

in a device. It also lets you swap gates of the same type
between devices of the same type.

• Pin swaps component pins with logically equivalent pins of the

same component.

• Undo undoes the most recent swap operation.

Align Menu

The Align menu contains commands you use to align items in the
database with a reference point. It also contains a command that
undoes the most recent align operation. The Align menu commands
are as follows:

• Objects aligns one or more objects with a reference point.

• Window aligns one or more components enclosed in or

intersected by a window with a reference point.

• Component aligns one component with a reference point.

• Undo reverses the previous Align command.

Placement Menu

The Placement menu contains commands that are used to create
potential component locations and placement barriers, and to place
components automatically according to their connectivity. The
Placement menu commands are as follows:

• Define Lattices creates placement lattices or matrixes, assigns

components to the lattices, defines clearances, and associates
discrete components with major (IC) components.
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• Define Barriers creates placement lattices or matrixes, assigns

components to the lattices, defines clearances, and associates
discrete components with major (IC) components.

• Enter Cutlines creates partition lines that divide the PCB into

areas that are used during automatic placement.

• Fix locks components in place to prevent them from being

relocated and swapped during automatic placement.

• Unfix restores components to normal status, allowing their

manipulation during automatic placement.

• Automatic Placement places components, and any discrete

components that have been associated, on one or more
predefined lattices. This placement is technically referred to as a
constructive initial placement.

• Histogram configures the placement bar graph or histogram,

defines the grid used to derive the histogram, generates a file
containing histogram statistics, and resets the histogram merit
factor.

Improve Plc Menu

The Improve Plc Menu contains commands to reduce the overall
wire length in the layout. The Improve Plc menu commands are as
follows:

• Components automatically swaps components to reduce
estimated overall wire length.

• Gates automatically swaps gates to reduce overall wire length.

Environment Menu

The Environment menu contains commands that influence how data
is placed in the database. The Environment menu commands are as
follows:

• DOS Shell lets you easily move from the PCB Editor to a DOS

environment where you can enter DOS commands.

• Change Units sets the database's unit of measure to English or

metric before you enter any intelligent information in the design.
The default is English.
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• Display Statistics shows statistical data about the internal

storage usage and capacity of the database. It also shows the
database's current unit of measure (English or metric), and the
filenames of the attached special symbol file and aperture table.

• Set Snap Tolerance specifies the radius of the snap tolerance,

measured in database units.

• Attach Padstacks attaches and detaches padstacks to the PCB

database to define pad sizes and geometries.

• Mask Items makes components and nets selectable or

unselectable.

• Assign Layer Pairs sets layers for interstitial vias, defines signal

(trace) layers, and assigns via types.

• Merge Polygon Voids merges freestanding voids with intelligent

or non-intelligent polygons.

• Min. Polygon Size stores a minimum allowable size for

polygons.

• Polygon Wire Clearance specifies the clearance around wires

embedded in polygons.

• Inner Plane Apertures tells the system which aperture numbers

you've assigned to inner layer planes to indicate connectivity.

• Set Minimum Aperture stores the smallest size aperture you

want to use for 0 width polygons. This size must be in your
aperture table but doesn't have to be the smallest size in the
table. The photoplotter uses the size you specify here when it
photoplots 0 width polygons. The system also uses this size
when

• You use Query!Polygon to determine whether a 0 width polygon

can be photoplotted.

• Polygon pouring or plowing occurs for 0 width polygons. If
polygons resulting from pouring or plowing can't be photoplotted
with the minimum size, the system highlights them and asks
whether you want the system to fix them.
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• Edit Aperture Table invokes the Aperture Table Editor where you

define apertures used in plotting and photoplotting your PCB.

• Clear Flashes merges freestanding flashes with intelligent or

non-intelligent polygons, and creates clearance around flashes.

• Polygon Flash Clearance defines the clearance around flashes

embedded in polygons.

Display Menu

The Display menu contains commands that directly or indirectly
control the graphics display. The commands affect the magnification
factor and displayed view of the design. The Display menu
commands are as follows:

• Store View lets you save up to 10 views of the design. You can

also store any one of the 10 views with the keyboard command
/st<n>, where <n> is the number of the view you want to store.
For example, the command /st4 saves the current view as view

number 4.

• Recall View lets you recall any of the views saved by using the
Store View command or the /st<n> command. You can also

recall any one of the 10 views with the keyboard command
/rc<n>, where <n> is the number of the view you want to recall.
For example, the command /rc4 recalls view number 4.

• Long Pan displays the current viewing screen and any stored

views in relation to the database. You can pan to a remote area
of the design by using the Long Pan command.

• Path/Group Visibility toggles between viewing and not viewing

critical paths and groups.

• Control Ratsnest sets constraints for display of the ratsnest.

• Measure displays the distance between a selected point and the

current position of the cursor.
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View Commands

The view commands are the frequently used commands that directly
or indirectly control the graphics display. The commands affect the
magnification factor and displayed view of the design. Commands
on the view command line are as follows:

• Redraw clears the graphics and draws them again.

• Pan moves the current viewing screen to a new location.

• Fit View displays the entire schematic sheet in the graphics
display area.

• View Layer changes a layer's color and status and sets the
active layer.

• View Window displays a specified rectangular area of the
schematic sheet.

• Zoom In increases the display magnification by a factor of 2 and
centers the display around a specified point.

• Zoom Out decreases the display magnification by a factor of 2
and centers the display around a specified point.

• Last View displays the previous view.

Keyboard Commands

You can enter commands into the system from the keyboard. First
type a forward slash (/). A slash signals the system that you're going
to enter a keyboard command.

Refer to the Keyboard Commands chapter in the Command
Reference manual for detailed descriptions of the keyboard-only
commands. Table 4-1 shows a list of the PCB Editor keyboard-only
commands. For a complete list of keyboard-only commands and a
cross-reference of keyboard to menu commands, refer to Appendix
E.
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Table 4-1.  Keyboard Only Commands
Command Description

/ably  (enable layer) Sets all layers to ABL (able)

/alyr (active layer) Sets any layer to ABL (able) and A (active)

/acf (automatic clear flash) Lets you control whether or not clearance is
automatically created around flashes during
polygon pouring.

/bend (bend toggle)  Toggles the direction of a wire bend or line
bend

/cfil (command log file) Controls command log file recording

/cpos (cursor position) Defines the final cursor position when a macro
finishes playing

/drc (design rules check) Lets you control whether or not the program
checks for spacing violations as you enter
wires

/dyn (dynamic ratsnest display) Controls the ratsnest display

/exe (execute) Plays a macro or command log file

/fast  (fast flash display) Displays flashes unfilled or unfilled

/grid (change grid size)* Lets you change the grid size

/intr (interrupt execution) Interrupts the macro or command log file

/lang (line angle)* Toggles between line angles

/lsty (line style)* Toggles between line styles

/lwid (line width)* Lets you set the line width

/lyrn (layer name)* Cycles through enabled layers on the status
line

/mac (macro) Starts the process of recording a macro

/mend (macro end) Ends the process of recording a macro

/menu (menu) Lets you cycle through the menu display
options

/ofly (off layer) Turns off all layers except the active layer

/only (on layer) Turns on all layers except the active layer

/pdel (program key-delete) Erases an assigned definition from one
programmed key

/pend (program key-end) Ends the process of programming a function
key

/pkey (program key) Starts the process of programming a function
key

/pkld (program key-load) Loads an ASCII file with programmed key
definitions

/pksv (program key-save) Saves the files of a programmed key

/pzap (program keys-zap) Erases assigned definitions from all
programmed keys

/rcp (recall cursor position) Returns the cursor to the position saved with
/scp

/rc1../rc10 (recall view) Recalls stored views 1 to 10

/regn (regenerate display list) Regenerates the display list

/resu (resume execution) Resumes macro or command log file
processing after interruption

/scp (save cursor position) Saves the position of the cursor in the graphics
area

/stgl (store global) Specifies the status area options to be saved
and played back when a macro is run
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/st1../st10 (store view) Stores views 1 to 10

/tmod (trace length display) Controls the display of trace lengths when you
enter wires

/ucp (uncommitted pin checking) Lets you control whether or not uncommitted
pins are added to nets when wires cross them

/vmbl Merges voids for a specific layer

/vmbp Merges voids for a specific polygon

/vmrg Merges freestanding voids

/wait (wait) Inserts a pause and message prompt in a
macro or command log file

/wcrv (wire/line curve) Lets you enter a curved wire or curved line

/xhar  (crosshair cursor) Lets you select a regular cursor or a vertical or
diagonal crosshair

*Also available on the status line

To enter a command from the keyboard

1. Type / (forward slash). The system prompts

Menu command:

Type the command and press ↵↵. (In most cases, the first three
unique letters of the command are sufficient to activate it.)
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Index
ably keyboard command, 69
Align commands

Component, 64
Objects, 64
Undo, 64
Window, 64

Allow Adding Uncommitted
Pins field
description, 17

alyr (active layer) keyboard
command , 47

alyr keyboard command, 69
Aperture Table Editor, 15
arrow, 7
asterisk, 7
Auto<<#106>Save Archive

field
description , 32

Auto<<#106>Save Extension
field
Auto?Save Extension field

description, 18, 31
Auto<<#106>Save Interval

Auto?Save Interval
setting the time, 31

Auto<<#106>Save Interval
field
Auto?Save Interval field

description, 18
Auto-Save Archive

description, 18
AutoSave Configuration

description, 18
Cancel button

description, 18
cfil (command log file)

keyboard command, 69
Check Pass Filename

description, 18
Chg. Layer commands

Attribute, 61
Component, 62
Object, 61
Objects, 61
Window, 61

commands, keyboard

alyr (active layer) , 47
drc (design rules checking),

26
list, 69

commands, menu
Histogram, 65

commands, view line
Fit View, 68
Last View, 68
Pan, 68
Redraw, 68
View Layer, 68
View Window, 68
Zoom IN, 68
Zoom Out, 68

component text
rotating, 20

configuration values
copying, 18, 33
saving, 33

Configure Editor tool
description, 14

configuring the PCB Editor
Editor Configuration tool,

18
conventions, 7
Convert Netlist to PCB tool,

15
Copy commands

Object, 61
Objects, 61
Trace, 61
Window, 61

Copy Default button
description, 18, 33

cpos (cursor position)
keyboard command, 69

Crit. Path commands
Add Gate, 62
Break Link, 62
Change Name, 62
Remove Definition, 62
Remove Gate, 62

cursor
moving to specific

coordinate, 40
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cycle, 8
cycle symbol, 8
database template

creating, 36
DBU, database unit

description, 37
English measurement, 37
metric measurement, 37
sub<<#106>mil resolution

sub?mil resolution, 37
default

auto file save time interval,
31

flash display size, 29
layers, 41
pin size, 29
via size, 29

Delete commands
Attribute, 61
Object, 61
Trace, 61
Undo, 61
Window, 61

Design Manager module, 13
Design Rules Check (DRC)

tool
description, 23
drc keyboard command, 26,

69
spacing violations, 23

Dimension commands
Adjust, 63
Angular, 63
Bind, 63
Center All, 63
Center One, 63
Configure, 63
Datum, 63
Diameter, 63
Leader, 63
Point, 63
Radius, 63
Unbind, 63

Display commands
Control Ratsnet, 67
Long Pan, 67
Measure, 67
Path/Group Visibility, 67
Recall View, 67
Store View, 67

Display Trace Length field

description, 17
displaying

dynamic ratsnests, 27
verbose warnings, 26

Displaying Verbose Warnings
description, 17

DOS Shell button
description, 18

Draw commands
2<<#106>Point Arc, 57
3<<#106>Point Arc, 57
Circle, 57
Circular Void, 58
Filled Rectangle, 57
Flash, 58
Line, 57
Polygon, 57
Polygonal Void, 58
Rectangle, 57
Text, 57

Draw Round Lines field
description, 17

drc (design rules check)
keyboard command, 26, 69

dyn (dynamic ratsnets
display) keyboard
command, 69

Dynamic Ratsnest Display
description, 17

dynamic ratsnests
displaying, 27

Edit Check Pass File
description, 17

Edit commands
Add Vertex, 58
Add Via, 59
Attribute, 59
Delete Segment, 59
Delete Trace, 59
Delete Vertex, 59
Delete Via, 59
Enter Wire, 58
Keyword, 59
Move All, 58
Move Segment, 59
Move Vertex, 59
Move Via, 59
Net Attribute, 59
Segment Layer, 59
Trace Width, 59
Undo Delete Segment, 59
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Edit Design Rules File
description, 17

Editor Configuration tool
accessing the DOS Shell,

18
adding radiuses to graphic

lines or wires, 17, 20
allowing uncommitted pins,

17, 21
Auto-Save Archive, 18
AutoSave Configuration, 18
autosave options, 30
Cancel button, 18
Check Pass filename, 18
checking for spacing

violations, 17, 23
copying the default

configuration values, 18,
33

creating clearance around
flash automatically, 17,
22

Design Rules filename, 17
determining screen redraw

speed, 17, 22
displaying trace length, 17,

21
displaying verbose

warnings, 17
Dynamic Ratsnest Display,

17
Edit Check Pass File, 17
Edit Design Rules File, 17
Exit button, 18
exiting the screen, 33
file auto<<#106>save time

interval
file auto?save time

interval, 18, 30
loading a function key file,

18, 28
loading a PCB

automatically, 17, 23
opening the screen, 18
rotating component text,

17, 20
rotating padstacks, 17, 19
saving the default

configuration values, 33

setting the
auto<<#106>save
archive , 32

setting the
auto<<#106>save
extension
setting the auto?save

extension, 18, 31
setting the flash size, 18, 29
setting the pin size, 18, 29
setting the via size, 18, 29
specifying minimum

spacing values , 24
Enter commands

Attribute, 57
Board Origin, 57
Polygon, 57
Ratsnest, 57
Replace Component, 57
Uncommit Pin, 57
Wire, 56

Environment commands
Assign Layer Pairs, 66
Attach Padstacks, 66
Change Units, 65
Display Statistics, 66
Dos Shell, 65
Inner Plane Apertures, 66,

67
Mask Items command, 66
Merge Polygon Voids, 66
Min. Polygon Size, 66
Polygon Wire Clearance, 66
Set Minimum Aperture, 66
Set Snap Tolerance, 66

exe (execute) keyboard
command, 69

Exit button
description, 18

field
Display Verbose Warnings,

26
File commands

Clear Database, 55
Create Plot, 54
Level Push, 55
Load, 54
Load Block, 55
Quit, 55
Save, 54
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Save Block, 55
Fit View command, 68
Flash Size field

description, 18
flashes

setting the display size, 29
setting the size, 29

function key
loading a default function

key file, 28
Function Key Filename field

description, 18
function keys

default for show grid, 39
loading automatically, 28

Gen. Auto<#1e>Insertion
Data tool, 15

Generate Drill Data tool, 15
Generate Reports tool, 15
graphics

rotating padstacks, 19
grid

controlling the spacing, 38
DBU measurement, 37
default setting, 37
moving the cursor by

coordinates, 40
showing, toggle on and off,

39
snapping the cursor, 39, 40

grid (change grid size)
keyboard command, 69

Group commands
Add Gate, 62
Change Name, 62
Remove Definition, 62
Remove Gate, 62

Histogram command, 65
Improve Plc commands

Components, 65
Gates, 65

Interfaces module, 13
intr (interrupt execution), 69
keyboard commands table, 69
lang (line angle) keyboard

command, 69
Last View command, 68
layer

activating, 47
changing the active layer,

46

changing the color, 44
changing the name, 47
changing the status, 44
creating  a new, 48
creating a new structure, 43
default, 41

layer structure
setting up, 41

Library Manager module, 13
Load Active PCB field

description, 17
Load PCB Editor tool, 15
lsty (line style) keyboard

command, 69
lyrn (layer name) keyboard

command, 69
mac (macro) keyboard

command, 69
mend (macro end) keyboard

command, 69
menu (menu bar display)

keyboard command, 69
menus

Align, 64
Chg. Layer, 61
Copy, 60
Crit. Path, 62
Delete, 61
Dimension, 63
Display, 67
Draw, 57
Edit, 58
Enter, 56
Environment, 65
File, 54
Group, 62
Improve Plc, 65
Move, 59
Name, 58
Placement, 64
Query, 55
Rotate, 60
setting the display, 48
slide-off, 7
Swap, 64
turning off and on, 48

modules
Design Manager, 13
Interfaces, 13
Library Manager, 13
PCB Tools, 13
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Schematic Tools, 13
Move commands

Attribute, 60
Component, 60
Critical Path, 60
Group, 60
Object, 59
Objects, 59
Undo, 60
Window, 59

Name commands
Component, 58
Net, 58
Reseq. Ref. Des., 58
Reseq. Window, 58
Subnet, 58

ofly (off layer) keyboard
command, 69

Online DRC field
description, 17

only (on layer) keyboard
command, 69

P<<#106>CAD database unit
P?CAD database unit

DBU, 37
padstacks

rotating, 19
Pan command, 68
PCB Editor

checking for spacing
violations, 23

creating a database
template, 36

loading a PCB
automatically, 23

prerequisites for using, 35
specifying minimum

spacing values , 24
the environment

setting the grid, 37
setting the grid spacing,

38
PCB Tools module

description, 13
tools

Aperture Table Editor, 15
Configure Editor, 14
Convert Netlist to PCB,

15
Gen. Auto<#1e>Insertion

Data, 15

Generate Drill Data, 15
Generate Reports, 15
Load PCB Editor, 15
Print or Plot File, 15
Report Editor, 15
Run Autorouter, 15
Run DRC, 15
Run PDIF<#1e>Reader,

15
Run PDIF<#1e>Writer,

15
window, 14

pdel (program
key<<#106>delete)
keyboard command
pdel (program key?delete)

keyboard command, 69
pend (program

key<<#106>end) keyboard
command
pend (program key?end)

keyboard command, 69
photoplotting

determining, 66
pin

adding uncommitted pins to
a net, 21

default display size, 29
setting the display size, 29

Pin Size field
description, 18

pins
setting the size, 29

pkey (program key) keyboard
command, 69

pkid (program
key<<#106>load) keyboard
command
pkid (program key?load)

keyboard command, 69
pksv (program

key<<#106>save) keyboard
command
pksv (program key?save)

keyboard command, 69
Placement commands

Automatic Placement, 65
Define Barriers, 65
Define Lattices, 64
Enter Cutlines, 65
Fix, 65
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Unfix, 65
Print or Plot File tool, 15
pzap (program

keys<<#106>zap) keyboard
command
pzap (program keys?zap)

keyboard command, 69
Query commands

Component, 55
Critical Path, 56
Group, 56
Net, 55
Net Pins, 56
Net Vias, 56
Object, 55
Padstack, 56
Pin, 55
Polygon, 56
Polygon Window, 56
Properties, 56
Trace, 55
Via, 56

radiuses
adding to graphic lines or

wires, 20
rcp (recall cursor position)

command, 69
Redraw command, 68
redrawing the screen, 22
Report Editor, 15
resu (resume execution)

keyboard command, 69
Rotate commands

Component, 60
Object, 60
Objects, 60
Undo, 60
Window, 60

Rotate Padstacks field
description, 17

Rotate Text in Four Directions
field
description, 17

rotating
component text, 20
padstacks, 19

Rules Filename
description, 17

Run Autorouter tool, 15
Run DRC tool, 15

Run PDIF<#1e>Reader tool,
15

Run PDIF<#1e>Writer tool,
15

Save Default button
description, 33

Schematic Tools module, 13
scp (save cursor position)

command, 69
stgl (store global) keyboard

command, 69
Swap commands

Component, 64
Gate, 64
Pin, 64
Undo, 64

template database
creating, 36

tmod (trace length display)
keyboard command, 70

trace
length

displaying while entering,
21

ucp (uncommitted pin
checking) keyboard
command, 70

units of measure
setting, 40

Use Display List field
description, 17

via
display size, 29

Via Size field
description, 18

vias
default display size, 29
setting the size, 29

View Command Line
description, 68

View Layer command, 68
View Window command, 68
violations

checking for spacing, 23
setting up check passes, 24
specifying minimum

spacing values, 24
vmbl (void merge by layer)

keyboard command, 70
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vmbp (void merge by
polygon) keyboard
command, 70

vmrg keyboard command, 70
wait keyboard command, 70
warnings

displaying, 26
wcrv keyboard command, 70
wid (line width) keyboard

command, 69
wildcard, 7

windows
PCB Tools, 14

wire
checking for spacing

violations, 23
crossing an uncommitted

pin, 21
xhar keyboard command, 70
Zoom In command, 68
Zoom Out command, 68
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